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fingerprint of synaptic connectivity, deployable in different experimental conditions.
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SUMMARY

Neurological disorders are defined by synaptic dysfunction. We present a work-
flow to quantify morphological and functional aspects of synaptic connectivity in
neuronal cultures and obtain an integrated readout. We describe steps for
measuring synchronous calcium bursting in GCaMP6f-transduced neurons and la-
beling mature synapses using a proximity ligation assay. The integration of func-
tional and morphological information from the same cultures provides a rich
fingerprint of synaptic connectivity, deployable in different experimental condi-
tions.
For complete details on the use and execution of this protocol, please refer to
Verstraelen et al. and Verschuuren et al.1,2
BEFORE YOU BEGIN

The protocol describes the morphofunctional assessment of synaptic connectivity in neuronal cul-

tures using calcium imaging and proximity-based labeling of mature synapses. This generic protocol

can easily be tuned to neuronal cultures of different origin such as primary rat, stem cell- or iPSC-

derived human cultures. Here, we apply it to primary cortical neurons derived from E18 mouse em-

bryos. The assay is performed at 21 days in vitro (DIV), a time point when synchronous calcium ac-

tivity and mature synapses are present.
Institutional permissions

The preparation of primary neuronal cultures from E18 mouse embryos was approved by the ethical

committee for animal testing of the University of Antwerp (file 2015–54). Viral vector (AAV) work at

the lab of Cell Biology and Histology of the University of Antwerp is described in the approved

biosafety file CDE-039.
Neuronal cell culture and transduction of the calcium sensor

Timing: 4 h hands-on + 3 weeks growth

1. Prepare primary cortical cultures from E18 mouse embryos.

a. The preparation of primary neuronal cultures has been detailed elsewhere.3

Note: Also the generation of iPSC-derived neuronal cultures has been detailed before.4
STAR Protocols 5, 102957, June 21, 2024 ª 2024 The Author(s).
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b. Plate neurons to a density of 10–15 3 103 cells/well in PDL-coated MW96 plates with trans-

parent imaging bottom (thickness: 0.17 mm). Fill the outer wells with 300 mL sterile liquid to

limit media evaporation.

Note: A cell density within the provided range allows the detection of synchronous calcium activity

while being sparse enough for morphological evaluation, i.e., a mono-layer of neurons. A higher

density ascertains synchronousburstingbut complicatesmorphological imageanalysis due toover-

lapping nuclei, neurites and PLA spots. Synchronous calciumbursts do not occur in sparse cultures.

2. Transduce the calcium sensor.

a. When the neurons have attached, typically 2 h after plating, add viral particles encoding the

calcium sensor.

Note: We use AAV-DJ-hSyn1-GCaMP6f-P2A-nls-dTomato for neuron-specific expression of

GCaMP6f (the cytosolic calcium sensor) and nls-dTomato (the nuclear counterstain). The

plasmid is obtained through Addgene (#51085) and packaged in house with a kit of Cell Bio-

labs (VPK-400-DJ), following the manufacturer’s instruction and using lipofectamine 2000 as

transfection reagent. The obtained crude lysate is sufficient for the described in vitro experi-

ments and does not need further purification.

b. Upon first use, test a dose range to balance expression efficiency and toxicity.

Note: In our experiment, 0.01 mL of the crude lysate is used per well of a MW96, resulting in

�80% transfection efficiency with no detectable cell loss (based on a DAPI cell count)

compared to non-transduced cultures. Transgene expression is detectable after 4 days and

is sustained for several (>6) weeks.

Note:A chemical calcium indicator such as Fluo-4-AM can be used as well, but has inherent limita-

tions as it requireswashing (whichoftenhalts the spontaneous activity), is only temporarily available

in the cytoplasm (typically �2 hours due to dye extrusion and compartmentalization), stains non-

neuronal cells as well (in contrast to the hSyn1 promoter used for GCaMP6f expression), and needs

to be combined with a membrane-permeable nuclei marker such as Hoechst to allow automated

cell segmentation. Dissolve Fluo-4-AM in a 10% Pluronic-F127 in DMSO solution to obtain a

10 mM stock. Loading is done in PBS (with calcium/magnesium) at a concentration of 5 mM Fluo-

4-AM at 37�C for 30 min. Imaging is done in PBS with calcium/magnesium at 37�C.

3. Maintain the cultures.

a. Add Cytosine arabinofuranoside (AraC; 100 nM final concentration in culturemedium) at 7 and

14 DIV.

Note: Some astrocytes should be present to support neuronal network formation, yet their

proliferation should be slowed down to prevent overgrowth. We do not use a pre-plated

astrocyte feeder layer.

b. Do not perturb the cultures until the time of analysis:
2

i. Do not remove media, only add media upon AraC treatment (e.g., 25 mL onto 150 mL). The

AAV particles are not washed away.

ii. Avoid temperature and CO2 drops by keeping the incubator closed as much as possible.

Pre-equilibrate media before adding to the cultures.

c. Monitor culture health.

Note: A low neuronal density and clustering of cell bodies are indications of poor culture health.

Such cultures do not show synchronous calcium activity at 21 DIV and should be discarded.
STAR Protocols 5, 102957, June 21, 2024
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Optimization of PLA staining

Timing: G 3 weeks

Proximity labeling of mature synapses involves targeting pre- and postsynaptic proteins with a pri-

mary antibody, followed by oligonucleotide-conjugated secondary antibodies. If both complemen-

tary oligonucleotides are in sufficient proximity (<40 nm), they are conjugated and amplified to

generate a fluorescent signal. Accurate PLA labeling therefore relies on the specificity of the pre-

as well as postsynaptic antibody. The following steps should be done to optimize the PLA labeling.

4. Make a selection of suitable pre- and postsynaptic antibodies, using single immunostainings and fluo-

rophore-conjugatedsecondaryantibodies.Thestainingshouldshowascrisppunctaalongtheneurites.

Note: For mouse primary neuronal cultures, we have used Bassoon as a pre- and Homer as a

postsynaptic staining, based on an unbiased evaluation of synapse markers.1 Other markers

such as synapsin (pre), synaptophysin (pre) or PSD95 (post) are regularly used as well.

5. Upon the first PLA trial, include the following controls:

a. Omit the pre- or postsynaptic primary antibody.

Note: This should not result in any PLA signal.

b. Combine markers that should not coincide at the same synapse, such as an excitatory (vGLUT)

with an inhibitory (vGAT) synapse marker.

Note: This should result in a minimal amount of PLA spots (proximity based on coincidence).

c. Combine fully overlapping markers, such as 2 pan-presynaptic markers (synapsin and synap-

tophysin) or 2 antibodies targeting different epitopes of the same protein.

Note: This should result in the maximal number of PLA spots.
Software installation

Timing: 15 min

6. Install Fiji/ImageJ from https://fiji.sc.

a. To allow nuclei segmentation via StarDist, as well as spot detection, install the Stardist,

CSBDeep and ImageScience plugins via Help > Update. > Manage update sites.

7. Install R and RStudio from https://posit.co/download/rstudio-desktop/.

KEY RESOURCES TABLE
REAGENT or RESOURCE SOURCE IDENTIFIER

Antibodies

Mouse monoclonal anti-Bassoon (clone L124/59,
final concentration of 2 mg/mL)

NeuroMab 73-491

Rabbit polyclonal anti-Homer1
(final concentration of 2 mg/mL)

Synaptic Systems 160003

Chicken polyclonal anti-MAP2
(final concentration of 2 mg/mL)

Synaptic Systems 188006

(Continued on next page)
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Continued

REAGENT or RESOURCE SOURCE IDENTIFIER

Donkey-anti-chicken-Alexa Fluor
647 (final concentration of 0.5 mg/mL)

Jackson ImmunoResearch 703-605-155

Bacterial and virus strains

pAAV-hSyn1-GCaMP6f-P2A-nls-dTomato Addgene 51085

AAV-DJ packaging kit Cell Biolabs VPK-400-DJ

Chemicals, peptides, and recombinant proteins

40,6-Diamidino-2-phenylindole (DAPI) Sigma D9542

Cytosine b-D-arabinofuranoside (AraC) Sigma C6645

Sodium azide (NaN3) Sigma 71290

Paraformaldehyde Acros 416785000

Triton X-100 Sigma X100

Critical commercial assays

Duolink in situ orange starter kit mouse/
rabbit (for proximity ligation assay)

Merck Millipore DUO92102-1KT

Duolink in situ microplate nuclear stain,
anti-fade

Merck Millipore DUO82064-1KT

Deposited data

Images and analyzed data BioImage Archive S-BIAD976

Software and algorithms

Fiji https://fiji.sc

Fiji plugin: StarDist Install via Help > Update. >
Manage update sites

Fiji plugin: CSBDeep Install via Help > Update. >
Manage update sites

Fiji plugin: ImageScience Install via Help > Update. >
Manage update sites

R and RStudio https://posit.co/download/
rstudio-desktop/

Image- and data analysis scripts https://github.com/DeVosLab/
NeuroConnectivity (https://doi.org/
10.5281/zenodo.10726334)

Other

96-well plate, 0.17 mm imaging bottom,
poly-D-lysine coating

Greiner Bio-One 655946
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MATERIALS AND EQUIPMENT

� Prepare fixation solution.
4% Paraformaldehyde

Reagent Final concentration Amount

Paraformaldehyde powder 4% 4 g

NaH2PO4.2H2O = 0.1 M phosphate buffer 306 mg

Na2HPO4.12H2O = 0.1 M phosphate buffer 288 mg

ddH2O N/A �100 mL

Total N/A 100 mL

Store at 4�C for up to 3 weeks.
Note: Add 80 mL ddH2O to paraformaldehyde while stirring and heating to 60�C. Then, add
NaH2PO4.2H2O and Na2HPO4.12H2O and fill up with ddH2O until 100 mL. Filter the solution.

CRITICAL: Work under a fume hood as paraformaldehyde powder is toxic.
4 STAR Protocols 5, 102957, June 21, 2024
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� Dissolve each of the PLA wash buffers (A and B; from PLA kit DUO92102-1KT) in 1 L high purity

water and store at 4�C for max 2 months. Before use, bring the buffers to 21�C.
� Dissolve the lyophilized antibodies to 1mg/mL using high purity water. Aliquot and store at‒20�C
for max 3 years.

� Prepare permeabilization solution by dissolving 0.5% Triton X-100 in PBS. Store at 4�C for max

3 months.

� Prepare 40,6-diamidino-2-phenylindole (DAPI) solution for nuclear counterstain: 5 mg/mL in PBS.

Store at ‒20�C for max 3 years.

CRITICAL: wear gloves as DAPI is toxic.

Note: The key resources and reagents for primary and iPSC-derived neuronal culture can be

found in Um et al. and Wang et al.3,4
STEP-BY-STEP METHOD DETAILS

Calcium imaging

Timing: 4 h for a MW96 with 60 wells

This step details the recording of spontaneous calcium activity in GCaMP6f-nls-dTomato-trans-

duced neuronal cultures. For each well, a 3-min time-lapse recording of calcium signal (GCaMP6f)

is made followed by a single image recording of the neuronal nuclei (nls-dTomato), which is used

for cell segmentation.

Note: Calcium fluxes are a proxy of spontaneous electrical activity; the synchronicity of cal-

cium bursts across neurons serves as a readout for synaptic connectivity.

1. At 21DIV, transfer theMW96 plate to themicroscope (pre-heated to 37�C) (troubleshooting 1 and 2).

a. Activate 5% CO2 supply and let equilibrate for 10 min.

Note: Imaging was done on a spinning disk confocal microscope, equipped with an auto-

mated stage, hardware autofocus system (Nikon Perfect Focus System), and environmental

control (5% CO2, 37�C). An epifluorescence microscope with image autofocus works as well.

2. Set up the microscope software (troubleshooting 3).

a. Use a 10X air objective.

b. Align the well plate in the microscope software. Add a single central point per well.

c. If present, adjust the offset of the hardware autofocus system. Else, set a software-based au-

tofocus, using the nls-dTomato channel as the reference.

d. Set acquisition settings of the fluorescence channels:
i. GCaMP6f: 488 nm excitation/525(W50) nm emission, 3 min @ 2 frames/sec, camera binning

2 3 2.

ii. Nls-dTomato: 561 nm excitation/615(W70) emission, 1 image, no camera binning.

e. Define general acquisition settings.

i. For each well, record a calcium time-lapse followed by a single image of nls-dTomato.

ii. Visit all wells. If present, keep the autofocus system continuously on. Else, perform an im-

age autofocus at each well.

3. Start the acquisition.

4. When finished, proceed to fixation.

CRITICAL: Excitation light is harmful to living cells due to the generation of reactive oxy-
gen species (ROS), a phenomenon known as phototoxicity. Therefore, it is important to
STAR Protocols 5, 102957, June 21, 2024 5
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keep the intensity of the excitation light as low as possible. Because calcium signals are

measured in the entire soma, limiting excitation light is more important than attaining

high spatial resolution. This is why GCaMP6f recordings can be made at 10X magnification

with camera binning 2 3 2. Nls-dTomato images are used for nuclei segmentation and

should therefore be recorded at binning 1. In this case, the ‘Resize factor’ is set to 0.5 in

the FIJI script.
PLA labeling and confocal microscopy

Timing: 3 days (�6 h hands-on time)

After calcium imaging, cultures are fixed and mature synapses are labeled with PLA. PLA is an anti-

body-based technique for proximity labeling whereby signal is generated when the pre- and post-

synaptic markers are in less than 40 nm proximity. A counterstain for the neurite network (MAP2) and

nuclei (DAPI) is performed as well.

Note:We have previously established that Bassoon (pre) and Homer (post) are good markers,

but PLA also works with other synapse marker combinations.1

Note: In principle, the morphological assay can also be performed with classical immunolab-

eling of a single synapse marker such as Synapsin or PSD95. However, such approach would

be less sensitive, as a significant proportion of synaptic spots are not connected to a post- or

presynaptic partner, suggesting that they are part of an immature synapse or reside extrasy-

naptically (e.g., trafficking). Upon staining of Homer-Bassoon or Synapsin-PSD95 combina-

tions, we typically find that only �50% of the spots of a given marker reside in mature syn-

apse.1 Second, the image analysis script allows colocalization measurements between two

synapsemarkers. This method exploits the inherent limitation on the spatial resolution of a mi-

croscope, as it looks for ‘colocalization’ while the marker proteins are in different anatomic

compartments. With synapse spots approaching the optical resolution limit, such measure-

ments are highly dependent on the optical alignment of both fluorescence channels. This is

circumvented by the PLA technique, as only 1 fluorescent spot is generated for each con-

nected synapse. A comparison between colocalization and PLA analysis on cultures at

different DIV and after MAPT (P301L) overexpression is shown in ref.1.

5. Fixation (day 1).

a. Gently remove medium from the well until 50 mL remains.

b. Add 50 mL of a 4% paraformaldehyde solution to obtain a final concentration of 2%.

c. Incubate for 20 min at 21�C.
d. Gently remove all liquid and switch to 200 mL PBS (pH 7.4).

Pause point: Each PBS or wash buffer A/B wash is considered a pause point. Upon pro-

longed pauses (e.g., after fixation), PBS with 0.1% NaN3 and a plate seal should be used to

prevent contamination and evaporation.

6. Permeabilization, blocking and primary antibody incubation (day 1).

a. All steps are done in a volume of 50 mL/well, unless stated otherwise.

b. Permeabilize with a 0.5% Triton X-100 solution in PBS for 5 min at RT.

c. Vortex Duolink blocking solution, remove permeabilization buffer, add blocking solution and

incubate for 1 h at 37�C.
d. Dilute Bassoon and Homer antibodies in Duolink antibody diluent (each 2 mg/mL). Remove

blocking solution, add 50 mL/well and incubate overnight (�16 h) at 4�C.
7. Main PLA procedure and counterstain (day 2).

a. Probe incubation.
6 STAR Protocols 5, 102957, June 21, 2024
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i. Vortex PLUS and MINUS PLA probes and dilute 1:5 in antibody diluent (9 + 9 + 27 mL per

reaction).

ii. Remove antibody solution and wash 2 3 5 min with wash buffer A.

iii. Remove wash buffer and incubate with PLA probes for 1 h at 37�C (40 mL/well). Use a plate

seal to prevent evaporation.

Note: Incubation of a MW96 plate was done on a heating block set at 37.5�C while covering

the plate with aluminum foil. The bottom should be in contact with the flat, heated surface

(turn the metal blocks upside down). This method is more accurate than incubation in an

oven. Setting the temperature at 37.5�C resulted in a temperature of 37�C in the well, and

finally in brighter PLA spots.

b. Ligation.

i. Dilute the 5x Duolink ligation buffer 1:5 in dH2O. Prepare 40 mL/well.

ii. Remove the PLA probe solution and wash 2 3 5 min with wash buffer A.

iii. During the last washing step, retrieve the ligase from the freezer and add 1 mL–40 mL liga-

tion buffer per reaction. Re-freeze left over ligase immediately after use.

iv. Remove wash buffer and incubate with ligation solution for 30 min at 37�C (40 mL/well). Use

a plate seal to prevent evaporation.

c. Amplification.

i. Dilute the 5x amplification buffer 1:5 in dH2O. Prepare 40 mL/well.

ii. Remove ligation solution and wash 2 3 5 min with wash buffer A.

iii. During the last washing step, retrieve the polymerase from the freezer and add 1:80 to

amplification buffer. Re-freeze left over polymerase immediately after use.

iv. Remove wash buffer and incubate with amplification solution for 100 min at 37�C (40 mL/

well). Use a plate seal to prevent evaporation.

Note: From the amplification step onwards, perform incubation steps in the dark to prevent

fluorochrome bleaching.

Optional: Check the PLA signal on the microscope. It should look like spots in the 561 nm

(red) channel, as shown in Figure 3A. The other channels are not yet occupied as counter-

stains are done in the next steps.

d. Counterstain: primary antibody.

i. Remove amplification solution and wash 2 3 5 min with wash buffer B.

ii. Dissolve MAP2 primary antibody to a final concentration of 2 mg/mL in antibody diluent

buffer.

iii. Remove wash buffer B and switch to wash buffer A for 5 min.

iv. Remove wash buffer A and add primary antibody solution (50 mL/well). Incubate overnight

(�16 h) at 4�C.
8. Counterstain: secondary antibody and DAPI (day 3).

a. Remove primary antibody solution and wash 2 3 5 min with wash buffer A.

b. Prepare secondary antibody solution (Donkey-anti-Chicken-Alexa Fluor 647, 0.5 mg/mL).

c. Remove wash buffer A and add secondary antibody solution (50 mL/well). Incubate for 2 h at

21�C.
d. Remove secondary antibody solution and incubate with DAPI solution (5 mg/mL; 50 mL/well)

for 10 min at 21�C.
e. Remove DAPI solution and wash 2 3 5 min with wash buffer A.

f. Remove wash buffer A and add anti-fade buffer (50 mL/well). Put a plate seal and store at 4�C.
9. Microscopy.

a. Transfer the plate to a (spinning disk) confocal microscope.

b. Use a 40X objective with a numerical aperture of 0.95 or higher.
STAR Protocols 5, 102957, June 21, 2024 7
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c. Align the plate in the microscope software. Add 20 random points/well.

d. If present, adjust the offset of the hardware autofocus system. Else, use a software- based au-

tofocus procedure e.g., using the MAP2 channel.

Note: Do not use the DAPI channel as the reference, as it is more sensitive to chromatic

aberration.

e. Set the acquisition settings:

i. 405, 561 and 640 nm excitation for DAPI, PLA and MAP2 resp.

ii. DAPI: 405 nm excitation / 470 (W24) emission.

iii. PLA: 561 nm excitation / 615 (W70) emission.

iv. MAP2: 640 nm excitation / 705 (W90) emission.

v. Small Z-stack with Nyquist spacing (�1 mm).

vi. Autofocus at each point.

f. Start the acquisition.

g. Remove the plate and store at 4�C with a plate seal.

Note: The PLA signal and nls-dTomato occupy the same fluorescence channel. This does not

introduce bias in the analysis as nuclei are excluded from the search region for PLA spots. The

PLA spots are much brighter than the background of the nls-dTomato signal, so this does not

interfere with synapse detection.

CRITICAL: Imaging should be done within 3 days after staining as the PLA signal fades
quickly.
Image analysis of calcium recordings

Timing: 1 h

Image analysis is performed in FIJI, using the ‘Neuroconnectivity_Func.ijm’ script. In each frame,

it measures the average calcium signal. It can measure in the full field-of-view, or in regions of

interest (ROIs) obtained via segmentation of cell objects in the time-projected calcium image

or nuclei in the corresponding nls-dTomato image. The main steps of the image- and data

analysis of calcium recordings are summarized in Figure 1. The impact of the most important

analysis settings (Gaussian filtering, fixed threshold settings and Stardist probability) are shown

in Figure 2A.

Note: The recordings, deposited on BioImage Archive, were analyzed with the default set-

tings of the provided scripts (via GitHub).

10. Export the images from the microscope software.

Note:Preferentially as .tif but the script accepts other file types aswell (.nd2, .ids, .jpg, .mvd2, .czi).
a. Add the well name to the filenames of the calcium and nuclei images. The subsequent R

script searches for the well code between two underscores (‘_[A-Z][0–9]{2}_’), e.g.,

‘_B02_’.

b. Add a suffix to the filename of the nls-dTomato images such that the script can pair a calcium

recording with its nuclear image (e.g., ‘_MarkerRoi’).
11. Install the Neuroconnectivity_Func.ijm macro via Plugins>Marcos>Install. Five additional tools

appear in the main FIJI window. Their name is displayed when hovering over them.
STAR Protocols 5, 102957, June 21, 2024



Figure 1. Signal- and data analysis of calcium recordings

(A) GCaMP6f and nuclei (nls-dTomato) images of 3 experimental conditions (B27 control, B27 minus anti-oxidants, and B27 minus anti-oxidants diluted

1:10). The GCaMP6f image shows the coefficient of variation to highlight the pixels with high calcium activity.

(B) Regions of interest (ROIs) are obtained through segmentation of the nls-dTomato image. Fluorescence-over-time traces of the different ROIs in a

recording show synchronous bursting (or absence thereof) in the different experimental conditions.

(C) Calcium traces are normalized and smoothed, followed by peak detection. A calcium trace of a random ROI of the control treatment in panel B was

used as an example.
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12. Open the Setup Tool and optimize settings:

a. General.
i. Time Serie Image Type – Select the file type of the input images.

ii. Pixel size – Fill out the pixel size in mm.

iii. ROI type – Calcium signal can be measured in the entire FOV, in ROIs derived from the

average calcium signal over time or ROIs based on an additional marker in a separate

image.

iv. If ‘Additional Marker’ is selected: Marker identifier – Fill out the suffix of the additional

nuclei image (e.g., ‘_MarkerRoi’ for the nls-dTomato image).

v. If ‘Additional Marker’ is selected: Marker Image Type – Select the file type of the additional

image (nls-dTomato).

vi. If ‘Additional Marker’ is selected: Marker resize factor – Define a ‘Resize factor’ to accom-

modate for different camera binning between the nuclei and calcium images.

b. Preprocessing:

i. Gaussian Blur Radius - Preprocesses the nuclei image by Gaussian smoothing.
STAR Protocols 5, 102957, June 21, 2024 9



Figure 2. Optimizing signal- and data analysis of calcium recordings

(A) GCaMP6f and nuclei (nls-dTomato) images to illustrate the optimization of different parameters. The GCaMP6f image shows the coefficient of

variation to highlight the pixels with high intensity variations (calcium activity). Gaussian filtering reduces noise in the image and smoothens edges of

detected ROIs with increasing kernel size (white arrowheads). When applying a user-defined threshold, higher thresholds results in fewer objects

detected (red arrowheads). If the Stardist algorithm is applied to detect ROIs, a higher probability setting results in fewer detected objects (blue

arrowheads). For this dataset, the best results were obtained by applying Stardist with a probability of 0.15 (white star). ROIs have a smooth border and

also very dim nuclei are still detected.

(B) Peak detection in the obtained calcium traces can be tuned by changing the minimal height of or distance between detected peaks. Increasing the

minimal height only retains peaks with high amplitude. A higher minimal distance only detects peaks that are sufficiently separated in time.
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Note:Gaussian filtering smooths the image by reducing image noise, but also reduces details

in the image. Higher values result in smoother, but potentially merged ROIs.

c. Segmentation:

i. Segmentation method – Intensity thresholding or Stardist (trained convolutional

network5) can be applied to detect nuclei.

Note: Intensity thresholding is faster, but Stardist usually works better with blurry images or

when many overlapping nuclei are present.

ii. If ‘Thresholding’ is selected: Method – Different automated threshold algorithms can be cho-

sen. If a user-defined thresholdhas tobeapplied, thefixed thresholdoptionhas tobeselected.

Note: Auto-thresholding makes use of the image content to determine a threshold. This

threshold is different for each image, and may cause problems in empty (black) images.

Therefore, a user-defined fixed threshold is recommended.

iii. If ‘Thresholding’ and ‘Fixed’ is selected: Fixed threshold value – User-defined threshold

value to apply to the preprocessed image.

iv. If ‘Stardist’ is selected: Probability - A probability threshold that the algorithm uses to

identify nuclei. A higher value results in less nuclei.

v. If ‘Stardist’ is selected: Overlap - Tolerated overlap between nuclei. A higher value results

in more overlap between nuclei.

vi. Prominence - For maximum finding and nuclei detection. A higher value results in a more

stringent criterion for nuclear separation.
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vii. Min and max ROI area - Filter the detected nuclei based on their size (in mm2).

Note: the Stardist method requires the Stardist and CSBDeep plugins (see above).
13. Open a calcium recording.

14. Analyze via the ‘Analyze Single Image Tool’.

Note: The obtained ROIs appear in the ROI manager and can be shown via the ‘Toggle Over-

lay Tool’. The image display settings can be adjusted via the B&C tool (Image>Adjust>Bright-

ness/Contrast).

15. Optimize the parameters for nuclei detection via the ‘Setup Tool’ (troubleshooting 4).

16. Once optimized, use the ‘Batch Analysis Tool’ to run all recordings in a given folder.

17. Use the ‘Verification Stack Tool’ to verify the segmentation on all analyzed images.
a. Select the folder where the images are located. After a batch run, this folder also contains a

subfolder named ‘Output’.

Note: Two hyperstacks are loaded: one with a time-projected image of the calcium signal and

another one with the nuclear marker image. Transparent nuclei masks are displayed as a second

channel.

b. Use the upper slider and B&C tool to adapt the display settings of the different channels.

c. Use the ‘Channels tool’ (Image>Color>Channels tool) to display one or both channels.

d. Use the lower slider to browse through analyzed images.
Signal- and data analysis of calcium recordings

Timing: 1 h

The ‘Neuroconnectivity_Func.R’ script is used to generate calcium traces, perform signal

analysis (peak detection, correlation measurements) as well as to plot and store the numerical cal-

cium data (Figure 1). Key steps regarding the optimization of the data analysis are shown in

Figure 2B.

Note: The .txt files generated by the FIJI script (in ‘‘Output’’ folder) are used as input for the R

script ‘Neuroconnectivity_Func.R’. In these .txt files, themean intensity of each ROI is given for

every time frame. In addition to this .txt files, the detected ROIs are saved as .zip files and can

be opened in Fiji if necessary.

Note: The data was analyzed using the default settings embedded in the R script.

18. Open the ‘Neuroconnectivity_Func.R’ script in RStudio. Load the required packages, as indi-

cated in the ‘Packages’ section.

19. Organize the output data and a plate layout .txt file as indicated in the R script.

Note: Replicate and plate folder names can be appended with any expression, e.g., Rep1 and

Plate1. The PlateLayout.txt file needs to be updated with your experimental layout. This file

can be opened in Excel but should be saved as a tab-delimited .txt file. The organized data

has also been deposited to BioImage Archive.
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Example:

Parent folder:

>Rep1

>Plate1

>Func

>Output

> PlateLayout.txt

>Rep2

>.
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20. Specify the input and output directories, using forward slashes.

21. Specify the settings:
a. Interval: the time resolution (in seconds) of the calcium recording.

b. Ctrl.condition: the control condition fromwhich themean and standard deviation are used to

calculate the Z-scores for data normalization (Notation: Condition_Treatment_Concentra-

tion). Z-scores are calculated per plate and replicate.

c. Peakheight: the minimal height of the normalized peaks.

Note:We recommend detecting the smaller peaks as well, to avoid missing data in recordings

with little activity. Therefore, the default is set at 1.05 (= 5% increase from the median

intensity).

d. Peakdistance: the minimal number of frames per peak.

e. ActivePeakNr: the minimal number of peaks that a neuron should show to be considered an

active neuron.

22. Beyond this point, no further user input is required (if the well notation is as described above,

e.g., ‘‘_B02_’’). Execute the script. The peak detection step may take several minutes. The

following multipage .pdf output is generated (in order of appearance):
12
a. Raw calcium traces, where the mean fluorescence intensity of each ROI is plotted in func-

tion of the time. One .pdf is generated in which each ROI is displayed on a separate graph

(Func_ROI_Raw), and a second .pdf where all ROIs of an image are shown on the same

graph (Func_Image_Raw). Different recordings are displayed on different pages of the

.pdf file.

b. Pre-processed traces (bleach correction > normalization > smoothing; Func_ROI_Norm).

The raw trace and its bleach-corrected version are plotted on the left Y-axis. The normalized

and smoothed versions are plotted on the right Y-axis. Normalization is done by dividing the

bleach corrected intensities by their median intensity over time. Next, smoothing (based on

local regression (loess)) is applied to this normalized trace to reduce noise.

Note: Peak detection happens on the smoothed version.

c. Peak detection results (Func_ROI_Peak). Peak maxima are indicated with red and minima

with orange dots.

Note: To speed up the process, the R script runs the peak detection on multiple cores (see

section 7 of the script). Your firewall may ask for permission to do so.

d. Raster plots with time on the x-axis and different ROIs stacked in the Y-direction

(Func_ROI_Peak_WellTile). Synchronous peaks appear as vertical lines.
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e. Peak detection results on averaged traces per image (Func_Image_AvTrace_Peak). The average

trace is calculated from all ROIs in a recording, such that synchronous peaks are represented but

non-synchronous peaks are averaged out. Hence, this representation informs on the synchronic-

ity, and allows to extract the frequency and amplitude of synchronous bursts.

Note: The peak detection on the averages traces takes the same input settings as the peak

detection on individual ROIs. If different settings for both trace types are desired, change

the input settings at the top of the script.

f. Barplots (Mean+SD)of thedataextracted from thecalcium traces. Stratified foreach replicateand

plate (Func_Well_Barplot_Rep_Plate), pooled across replicates/plates (Func_Well_Barplot) or

normalized to the control condition (defined in section 1.2 of the script). The mean and standard

deviation of the control condition are used to calculate the Z-scores per replicate/plate.

(Func_Well_Norm_Barplot and Func_Well_Norm_Barplot_Rep_Plate). The following parameters

are plotted:
i. Baseline intensity: median intensity within ROIs.

ii. Peak frequency (nr. per sec).

iii. Peak duration (in sec).

iv. Peak interval (in sec).

v. Peak duration variability: standard deviation of the peak duration divided by the mean

duration.

vi. Peak interval variability: standard deviation of the peak interval divided by the mean

duration.

vii. Dynamic range: difference between max and min raw intensity per ROI.

viii. Dynamic range norm: difference between max and min normalized intensity per ROI.

ix. Active fraction: the percentage of neurons considered ‘active’ (defined in section 1.4).

x. Parameters derived from the active neurons only (inactive are no longer considered):

baseline intensity, peak frequency, peak duration, peak interval, peak duration vari-

ability, peak interval variability, dynamic range and dynamic range norm.

xi. Parameters derived from the average traces: baseline intensity, peak frequency, dy-

namic range and dynamic range norm.

xii. Average correlation: the mean of the Pearson’s correlation matrix across all ROIs of a

recording.

xiii. Synchronous fraction: the percentage of ROIs that show >70% correlation.

Note: Dimensionality reduction and integration with morphological data requires a different

script (Neuroconnectivity_Profiling). In case only functional or morphological, but not both,

assays are done, part of the profiling script remains useful, e.g., for generating PCA plots.
Image analysis of neuronal network morphology

Timing: 1 h hands-on + batch run

Neuronal network morphology is analyzed using the FIJI script ‘NeuroConnectivity_Morph’. Nuclei are

detected using a manually assigned threshold or via Stardist. Neurites are identified using a rough

(user-defined threshold) and fine segmentation (user-defined threshold after tubeness filtering). The

area covered by neurites is measured, i.e., the neurite mask, and secondly, skeletonization is performed

tomeasure the neurite length and the number of branch points. Next, the nuclei mask is subtracted from

the neurite mask after which the newmask is dilated to obtain a search region in which synaptic spots are

detected. The spots are first enhanced using a Gaussian, Laplacian or multi-scale Laplacian filter with a

user-defined kernel size. Next, a threshold is applied to segment the synapse spots. An overview of the
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Figure 3. Analysis of neuronal network morphology

(A) Nuclei (DAPI), neurites (MAP2) and mature synapses (Bassoon-Homer PLA) of 3 experimental conditions, and their composite image.

(B) Segmentation results of the images corresponding to panel A.

(C) The experiment entailed 3 biological replicates, with 6 technical (well) replicates for every condition. To reduce plate effects, data was normalized.

Heatmaps showing 3 variables of the control treatment across different wells and replicates illustrate two different normalization strategies. In this

analysis, data is normalized to control conditions based on the mean and standard deviation of control wells of that plate (Z-Score CTRL) rather than

based on the mean and standard deviation of the pooled data of the entire plate (Z-Score ALL).
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segmentation and data normalization procedure is shown in Figure 3. The key steps for optimizing the

image analysis of nuclei, neurites and PLA spots are shown in Figure 4.

23. Export the images from the microscope software.

Note: Preferentially as multipage .tif (pages are fluorescent channels) but the script accepts

other file types as well (.nd2, .ids, .jpg, .mvd2, .czi). Export as a maximum intensity projection,

or use the Z Project Tool (see below).

24. Install the Neuroconnectivity_Morph.ijm macro via Plugins>Marcos>Install.

Note: Nine additional tools appear in the main FIJI window. Their name is displayed when

hovering over them.

Note: In case Z-stacks were exported, use the ‘Z-project Tool’ to generate maximum intensity

projections. The script works with single-plane (projected) images only.
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Figure 4. Optimizing the detection of the neuronal network

(A) Nuclei are detected via thresholding or by applying the Stardist algorithm. A median filter is first applied to reduce noise and decrease the intensity

differences within nuclei, resulting in smoother nuclei ROIs (white arrowheads). After this preprocessing step, an optimal threshold allows to segment

individual nuclei without merging (threshold too low, left red arrowhead) or partial (threshold too high, right red arrowhead) nuclei. If the Stardist

algorithm is chosen, the probability parameter defines which objects are seen as nuclei. Increasing the probability reduces the number of nuclei (blue

arrowhead). The most optimal combination of the illustrated settings has been highlighted with a white star.

(B) Neurite detection is performed after preprocessing with a median filter. A higher filter scale reduces noise, but also removes more subtle details of

the marker (white arrowheads). Next, a first rough thresholding is done on this preprocessed image. A high threshold results in a lower neurite area (red

arrowheads). Then, fine neurites are enhanced using a tubeness filter. This enhancement step can be tuned by altering the scale of this filter. Smaller

scales allow the detection of smaller neurites (blue arrowheads). Finally, a fixed threshold is applied to the filtered mask (a lower neurite area is detected

when the threshold in increased; red arrowheads). The most optimal combination of the illustrated settings is highlighted with a white star.

(C) Spots are detected after Laplacian enhancement. Increasing filter scales highlight larger spots (white arrowhead). Next, a threshold is applied to this enhanced

image. Higher thresholds result in fewer spots being detected. The most optimal combination of the illustrated settings is highlighted with a white star.
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25. Use the Setup Tool to optimize the analysis parameters: troubleshooting 5.
a. General.

i. Image Type – Select the file type of the input images.

ii. Pixel Size – Fill out the pixel size in mm.

iii. Channel Number – The number of channels in the images.

iv. Detectable Objects – Select which objects need to be detected.

b. Nuclei parameters:

i. General: Nuclei Channel – Set the nuclei (DAPI) channel.
STAR Protocols 5, 102957, June 21, 2024 15



ll
OPEN ACCESS

16

Protocol
ii. General: Segmentation method – Intensity thresholding or Stardist (trained convolu-

tional network5) can be applied to detect nuclei.

Note: Intensity thresholding is faster, but Stardist usually works better when many overlap-

ping nuclei are present.

iii. Preprocessing: Background subtraction – Correct uneven illuminated background by

estimating and subtracting the local background in images.

iv. Preprocessing: Local Contrast Enhancement – Implement ‘contrast limited adaptive his-

togram equalization (CLAHE)’ to enhance the local contrast in an image.

Note: Images with high variability in average nuclear intensities can benefit from this prepro-

cessing step.

v. Preprocessing: Preprocessing Method – Apply Gaussian, median or Laplacian filtering

prior to nuclei detection.

Note:Gaussian andmedian filtering smoothens the image by reducing image noise, but also

reduces details in the image (more pronounced with Gaussian filtering). Laplacian filtering

enhances round structures in an image according to the used filter size.

vi. Preprocessing: Filter Size – The kernel size used for filtering.

Note: A larger kernel size for Gaussian or median filter increases noise reduction, but sup-

presses more subtle morphological details, whereas the kernel size for Laplacian filtering de-

fines the size of objects that are enhanced in the image (the larger the filter size, the larger the

objects that will be enhanced).

vii. Threshold Settings: Threshold Method – Different automated threshold algorithms can be

chosen. If a user-defined threshold has to be applied, select the fixed threshold option.

Note: Auto-thresholding makes use of the image content to determine a threshold. This

threshold is different for each image, and may cause problems in empty (black) images.

Therefore, a user-defined fixed threshold is recommended.

viii. Threshold Settings: If ‘‘Fixed’’ is selected: Fixed thresholds – Apply a user-defined

threshold value to the preprocessed image.

ix. Threshold Settings: Watershed Separation – Use the watershed algorithm to split adja-

cent nuclei that were detected as one object.

x. Stardist Settings: Probability – A probability threshold that the algorithm uses to identify

nuclei. A higher value results in less nuclei.

xi. Stardist Settings: Tolerated Overlap – Tolerated overlap between nuclei. A higher value

results in more overlap between nuclei.

xii. Stardist Settings: Min. intensity – To avoid detection of false positive nuclear regions, set

a minimum intensity.

xiii. Object filters: Min. Circularity – Filter nuclei based on their circularity.

xiv. Object filters: Min and Max area – Filter nuclei based on their minimum and maximum area.

c. Neurite parameters:

i. General: Neurite Channel – Set the neurite channel.

ii. Preprocessing: Contrast Enhancement – Implement ‘contrast limited adaptive histo-

gram equalization’ (CLAHE) to enhance the local contrast in an image.

Note: Images with an intensity gradient can benefit from this preprocessing step.
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iii. Preprocessing: Median Filter – Median filtering reduces noise in the image.

iv. Preprocessing: Median Filter Scale – A larger kernel size for median filter increases noise

reduction, but also suppresses details in the image.

v. Tubeness Enhancement Settings: Scale – Enhance fine neurites for subsequent thresh-

olding. A smaller scale leads to the enhancement of very fine neurites.

vi. Threshold Settings: Fixed Threshold Fine – Set a fine threshold for segmenting the small

neurites after tubeness enhancement.

vii. Threshold Settings: Fixed Threshold Rough – Set a rough threshold for the larger neu-

rites and cell bodies.

viii. Object filters: Min Area Fragments – Filter out the smaller fragments if needed.

ix. Search Area: Dilation Search Region – The resulting mask is dilated with a user-defined

number of pixels to obtain a search region. The following colors are used: cyan for the

skeleton, yellow for the neurites, and magenta for the search region.

Note: Synapse spots are only considered when they fall within the search region.

x. Search Area: Dilation Nuclei Exclusion – The nuclei mask is subtracted from the neurite

mask. Set the number of pixels with which the nuclei is dilated before subtraction of the

neurite mask (to cover the soma).

Note: To optimize the fine and rough neurite thresholds, set one very high while optimizing

the other.

Note: A sufficiently high nuclei dilation setting excludes the entire neuronal soma and

thereby improves the neurite skeletonization results (avoiding lots of smaller segments

within the soma).

d. Spot parameters for spots A/B:

Note: If no second spot marker is used, fill out 0 as spot channel B.
i. Settings Spots A/B: Spot Channel A/B – Select the channel number of spot channel A.

ii. Settings Spots A/B: Segmentation Method – The spots are first enhanced using a

Gaussian, Laplacian or multi-scale Laplacian filter.

Note: Laplacian filters specifically enhance spot-like features in the image and are therefore

ideally suited to detect synaptic spots in the images.

iii. Settings Spots A/B: Filter Scale – Set the kernel size of the applied filter. A higher filter

scale results in larger spots being detected.

iv. Settings Spots A/B: Threshold Method – Apply a threshold to segment the synapse

spots. Different automated threshold algorithms can be chosen. If a user-defined

threshold has to be applied, select the fixed threshold option.

Note: Auto-thresholding makes use of the image content to determine a threshold. This

threshold is different for each image, and may cause problems in empty (black) images.

Therefore, a user-defined fixed threshold is recommended.

v. Settings Spots A/B: If ‘‘Fixed’’, fixed threshold – Set the fixed threshold if ‘fixed’ is chosen

as threshold method.

vi. Settings Spots A/B: Min and Max Spot Size – Filter spots based on their minimum and

maximum area.
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vii. Colocalization: Colocalize spots – Calculate colocalization metrics: Pearson correlation

and number of overlapping spots. Only applies when 2 spot channels are defined.
26. Open an image, optimize the contrast of the different channels via the B&C dialog, and use the

‘Segment Nuclei’, ‘Segment Neurites’ and ‘Segment Spots’ tools.

27. Use the ‘Toggle Overlay’ tool to visualize the ROIs, and optimize the segmentation parameters

via the ‘Setup Tool’.

Note: The overlay of ‘Segment Neurites’, shows the neurites (yellow), search region (magenta)

and skeleton (cyan).

28. Analyze an open image with the ‘Analyze Single Image Tool’ or analyze all images in a folder

using the ‘Batch Analysis Tool’.

29. Use the ‘Verification Stack Tool’ to verify the segmentation on all analyzed images. Select the

folder where the images are located. After a batch run, this folder also contains a subfolder

named ‘Output’. If desired, make a subselection can be made based on the file index.

Note:Make sure that the desired objects (nuclei, neurites, spots) are checked in the ‘Setup Tool’.

Note:Once loaded, 2 sets of images and their corresponding masks are present. Mask are repre-

sented as additional channels. The first set allows to check the nuclei, neurites and search region,

while the second set allows to check synapse spots, which are detected within the search region.
a. Use the upper slider and B&C tool to adapt the display settings of the different channels.

b. Use the ‘Channels tool’ to display the desired channels, and change their colors (via ‘More’).

c. Use the lower slider to browse through analyzed images.
Data analysis of neuronal network morphology

Timing: 1 h

The summary.txt files are used as input for the R script ‘Neuroconnectivity_Morph.R’. This script is

used to compile and plot the morphological data (nuclei, neurites, PLA synapse spots).

Note: The .txt files generated by the FIJI script are stored in the ‘‘Output’’ folder. A single .txt file is

saved for the nuclei, neurites, skeletonized neurites, search region and spots per image. The corre-

lated ROIs are also saved as a .zip file and can be opened in Fiji if needed. A summary.txt file is

generated by the Fiji script for every image that combines neurite information (neurites, skeleton

and search region) with averaged and summed parameters of all nuclei and spots in the image.

Note: The output parameter names should be read as follows:

Morphological structure: neurites, skeletonized neurites, search region, nuclei or spots.

SC: segmented channel.

Features: area, mean, standard deviation, mode, min, max, perimeter, circularity, ferret, integrated

density, median, skewness, kurtosis, etc. These features are explained in the FIJI documentation

(https://imagej.net/ij/docs/menus/analyze.html).

MC: measured channel.

Mean/Sum: average or sum of all nuclei/spot.
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For instance, ‘Neurites_SC1_Mean_MC2’ represents themean intensity of channel 2 (PLA) measured

in the neurite mask, which was segmented based on channel 1 (MAP2).

30. Open the ‘Neuroconnectivity_Morph.R’ script in RStudio. Load the required packages, as indi-

cated in the ‘Packages’ section.

31. Organize the output data and a plate layout .txt file as indicated in the R script.

Note: Replicate and plate folder names can be appended with any expression, e.g., Rep1 and

Plate1. Update the PlateLayout.txt file with your experimental layout. This file can be opened

in excel but should be saved as a tab-delimited .txt file. The organized data has also been

deposited to BioImage Archive.
Example

Parent folders:

>Rep1

>Plate1

>Morph

>Output

> PlateLayout.txt

>Rep2
32. In the R script, specify the input and output directories.

Note: These directories can be the same for the morphological and functional data.

33. Specify the control condition from which the mean and standard deviation per plate and repli-

cate is used to calculate the Z-scores (Notation: Condition_Treatment_Concentration).

Note: Beyond this point, no further user input is required, except for the adaptation of regular

expressions to find the well index if needed.

34. Execute the script. The following multipage .pdf output is stored in the output directory ‘Neu-

ro_Morph_Plots’ (in order of appearance):

>.
a. Violin plots of all morphological parameters (Morph_Image_Violin). The violin plot is based

on datapoints that represent one image. Different parameters are on different pages of the

.pdf file.

b. Plate overviews of all morphological parameters (Morph_Well_PlateOverview). Results

from all fields are averaged per well, and the well data is represented as a heatmap.

An overview of the plate layout is generated as well (Morph_Well_PlateOverview_Layout).

Note: This visualization allows to easily detect plate effects, e.g., when cells have not grown

properly in the outer wells, as well as toxic conditions.

c. Barplots (Mean + SD) with one datapoint representing one well (fields are averaged). One

.pdf with all data compiled (Morph_Well_Barplot), and one stratified per replicate and plate

(Morph_Well_BarPlot_Rep_Plate).

d. Plate overviews of normalized well data (Morph_Well_Norm_PlateOverview.pdf).
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e. Barplots (Mean + SD) of normalized parameters with one datapoint representing one well

(fields are averaged). One .pdf with all data compiled (Morph_Well_Norm_Barplot), and

one stratified per replicate and plate (Morph_Well_Norm_BarPlot_Rep_Plate).
35. The numerical data is saved as tab-delimited .txt files in the ‘Neuro_Morph_MergedData’ sub-

folder of the output folder that was specified in the script.

Note: Dimensionality reduction and integration with morphological data requires a different

script (Neuroconnectivity_Profiling). In case only calcium or morphological, but not both, as-

says are done, part of this script remains relevant, e.g., for PCA plots.
Morphofunctional data integration

Timing: 1 h

The R script ‘NeuroConnectivity_Profiling’ is designed to integrate the morphological (nuclei, neu-

rites, synapses) with functional data (calcium activity). The combined dataset is represented as a

heatmap. Principal Component Analysis (PCA) is performed to reduce data dimensionality and PC

plots are construed to visualize whether experimental groups separate in PC space.

36. Open the ‘Neuroconnectivity_Profiling.R’ script in RStudio. Load the required packages, as indi-

cated in the ‘Packages’ section.

37. Specify the folders that contain the morphological and functional data (folder names ending

on ‘_MergedData’).

Note: This requires that the last lines of the ‘Neuroconnectivity_Morph’ and ‘Neuroconnecti-

vity_Func’ scripts were executed. The normalized data (Z-scores) are used.

38. Specify the folder in which the results of Profiling script are stored.

39. No user input is required past this point except for the color coding of the heatmap groups as

well as the PCA (in the script). Execute the script. The following graphical output is generated in

the output directory ‘Neuro_Profile_Plots’:
a. Heatmaps of morphological, functional, and combined morphofunctional data.

Note: Z-scores are first standardized over the whole data set to obtain features that are all

within the same range. Hierarchical clustering is used to group the parameters (on top) and

the conditions (ID and replicate; on the left).

b. PCA plots of PC1 and PC2 of morphological, functional and combined morphofunctional data.

Note: Z-scores are first standardized over the whole data set to obtain features that are all

within the same range. The explained variance by each PC is indicated on the axis labels. El-

lipses represent a 95% confidence level based on a t-distribution.

40. The numerical data of the PCA (scores and rotation matrix) are saved as tab-delimited .txt files in

the ‘Neuro_Profiles_MergedData’ subfolder of the output folder which was specified in the

script.
EXPECTED OUTCOMES

The assay enables rapid high-content screening of treatments that modulate morphofunctional syn-

aptic connectivity in dissociated neuronal cultures. We have cultured primary mouse neuronal net-

works in 3 different media. Control cultures were grown in Neurobasal medium with 2% B27 supple-

ment. In parallel, a culture was grown with 2% B27 minus anti-oxidants (B27 -AO), which hence
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experienced more oxidative stress. Finally, one set of cultures received a 1:10 dilution of this anti-

oxidant-deprived medium (B27 1:10 -AO), modeling oxidative stress and starvation. Each condition

was repeated on 6 well replicates, and the entire experiment was performed on 3 separate cultures

(dissections of 3 mother mice of which the E18 embryos were pooled).

The morphological assay yielded different readouts such as the number of nuclei, neurite area/

length and PLA spot density (Figure 5A). The functional assay informed a.o. about the fraction of

active neurons, peak frequency, fraction of synchronous neurons and correlation across neurons

(Figure 5A). These and other parameters were combined into one morphofunctional fingerprint

and visualized via hierarchically clustered heatmaps (Figure 5B), and PCA (Figure 5C). The latter

shows the advantage of the integrated approach. While the B27 -AO condition did not differ from

the controls with respect to network morphology, it showed a different pattern of spontaneous cal-

cium activity. The combined PCA revealed the best separation between controls, B27 -AO and B27

1:10 -AO. Thus, integrated high-content screening enables a more sensitive detection of com-

pounds that modulate synaptic connectivity in vitro.

LIMITATIONS

The validity of the assay depends heavily on the quality of the neuronal cultures. Immature or

stressed neurons show a low proportion of mature (connected) synapses and do not show synchro-

nous activity, or a lower frequency/amplitude thereof at best. In our experience, the presynaptic

marker is easy to detect, but the postsynaptic marker requires a more advanced maturation state.

Nuclei detection may prove challenging in dense cultures. In this case, we advise to use Stardist, as it

separates overlapping nuclei better than a classical segmentation/watershed approach. Given that a

rough threshold (for somata and larger neurites) and fine threshold (for fine neurites) are combined,

neurite area can reliably be detected. However, the detection is not done per cell, but per image, so

that a different neuronal density also affects the neurite area. One can calculate a new parameter,

neurite area divided by the nuclei count, to obtain an approximation of the average neurite area

per cell in a given condition. In addition to the area measurement, skeletonization is done on the

neurite channel to quantify the neurite length and number of branch points. However, the accuracy

of the skeleton depends on the cell density. A higher density comes with more neurite crossing and

fasciculation neurites putting a bias on the measurements.

Even though we have not fully validated our workflow on brain tissue or cerebral organoids, the pro-

vided staining/imaging/analysis protocols may serve as a basis to assess synaptic connectivity in

these models.

TROUBLESHOOTING

Problem 1

No GCaMP6f-nls-dTomato expression or high toxicity (related to step 1).

Potential solution

The viral transduction efficiency depends on the neuronal cell type (primary, iPSC-derived etc.) and

their health status. Try a dose range of the AAV particles, or choose a different serotype (e.g., AAV9)

or viral vector (e.g., lentivirus). A chemical calcium indicator such as Fluo-4 or Cal6 can be used as

well, preferably in combination with SiR-DNA nuclear counterstain.

Problem 2

No (synchronous) calcium activity (related to step 1).

Potential solution

In primary cultures prepared from E18 mice, calcium activity is present at all DIVs. Synchronicity first

appears at 10–14 DIV and stays thereafter. A higher neuronal density results in faster synchronization
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Figure 5. Expected outcomes

(A) Bar graphs of intuitive parameters, shown as absolute values (on top) or normalized Z-scores (below), for 3 experimental conditions.

(B) Heatmaps of Z-scores with hierarchically clustered conditions/replicates and parameters. Network morphology, calcium activity and their

combination are shown on different heatmaps.

(C) Principal Component Analysis (PCA) plots show that even though neurons grown without anti-oxidants (B27 -AO) do not show gross morphological

aberrations, their spontaneous bursting pattern is different from controls. The combined morphofunctional approach results in the best separation

between the 3 experimental conditions.
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of the activity, hence an experiment with different seeding densities is advised. Astrocytes facilitate

synchronous activity, so the AraC concentration should be titrated to have at least 20% astrocytes in

the culture. Neuronal cultures that do not come with astrocytes, such as iPSC-derived neurons,

benefit from using a pre-plated feeder layer of astrocytes. Also, acute application of 10 mM forskolin

(while imaging) should drastically enhance calcium activity.

Problem 3

Microscope software does not allow complex acquisition protocols needed for automated record-

ings of GCaMP6f and nls-dTomato. At each point, a time-lapse recording of GCaMP6f should be

made, immediately followed by an nls-dTomato image. Only then, the stage should move to the

next point (related to step 2).

Potential solution

Use auto-mouse clicker freeware as a work around.

Problem 4

Nuclei images are difficult to segment (related to step 15).

Potential solution

� Note that nls-dTomato images can be difficult to segment because of high background or variable

expression levels (also in function of the experimental condition at hand). Hence, a perfect seg-

mentation of all neurons in all conditions may be hard to achieve. Detection of non-existing nuclei

should be avoided, but missing a limited number of nuclei does not necessarily affect the main

measurements (correlation, (synchronous) bursting amplitude/frequency). Segmentation perfor-

mance should be checked by comparing with manually annotated ground-truth.

� The FIJI script can work with other ROI types, including the full field-of-view, or cell segmentation

based on the average-projected calcium image. Not that the latter is less preferred than a nuclei

image since it is no longer independent of the calcium activity.

� Before imaging, the membrane-permeable dyes Hoechst or SiR-DNA can be added to stain the

nuclei. Note that these dyes also stain non-neuronal nuclei and may not be compatible with re-im-

aging the same cultures on different days.

Problem 5

No nuclei, neurites or synapse spots are detected (related to step 25).

Potential solution

� No objects are detected if the threshold is set too high, or too low, especially when combined with

a stringent size/roundness filter. As a first step, remove the particle filters.

� For the nuclei and rough neurites threshold, one can hover over the pixels of a given image to es-

timate the background and foreground intensity, which is displayed in the main FIJI GUI. The fine

neurite threshold and the spot threshold are set on secondary images, so this requires a trial-and-

error approach.

RESOURCE AVAILABILITY

Lead contact

Further information and requests for resources and reagents should be directed to and will be ful-

filled by the lead contact, prof. Dr. Winnok H. De Vos (winnok.devos@uantwerpen.be).

Technical contact

Questions about the technical specifics of performing the protocol should be directed to and will be

answered by the technical contact, Peter Verstraelen (peter.verstraelen@uantwerpen.be).
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Materials availability

This study did not generate new unique reagents.

Data and code availability

Image data and raw results file are available via the BioImage Archive database (https://www.ebi.ac.

uk/biostudies/bioimages/studies) under accession number S-BIAD976. The Fiji as well as R scripts

are available on GitHub (https://github.com/DeVosLab/NeuroConnectivity, Zenodo: https://doi.

org/10.5281/zenodo.10726334).
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